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INTRODUCTION

The City of Elk Grove is accepting proposals from qualified affordable housing developers to
construct new affordable multifamily housing within the City of Elk Grove in accordance with the
included specifications, terms, and conditions shown in this Request for Proposals (RFP). The City
has approximately $8 million available that may be loaned to two or more qualified projects. This
RFP is being released to identify experienced and eligible affordable housing developers wishing
to develop, construct, and operate affordable multifamily rental housing. Prospective
respondents are advised to read this information carefully prior to submitting a proposal.

The City anticipates funding one project that is ready to proceed and will submit for 9% low-
income housing tax credits (LIHTC) in the July 1, 2021 round. The City also anticipates funding one
or more projects that rely on other funding sources, such as 4% LIHTC, Affordable Housing and
Sustainable Communities funding, Multifamily Housing Program, or 9% LIHTC funding in 2022 or
beyond.

One digital PDF copy must be submitted to the Office of the City Clerk by March 24, 2021 at
4:00pm for 9% LIHTC projects submitted in July 2021 or by May 19, 2021 at 4:00pm for all other
projects. Proposals shall be addressed to the City Clerk Jason Lindgren
at jlindgren@elkgrovecity.org, with a copy to Sarah Bontrager at sbontrager@elkgrovecity.org.
Submittals in PDF format must be fully ADA compliant. Large files may be sent using a cloud-
based system such as Dropbox. Proposers shall be responsible for ensuring that proposals
submitted electronically are received by the City Clerk prior to the deadline. Proposals that are
not received prior to the deadline shall not be considered by the City, even if the late submission
is due to a technical or other error, including, without limitation, the City's inability to open or
access the electronic file. If the proposer does not receive a confirmation from the City Clerk that
the proposal has been received, proposer should assume the transmission failed and either
resubmit or arrange for another method of delivery. Proposers are also encouraged to contact
the City Clerk to confirm receipt of their proposal prior to the deadline. Proposals shall not be
accepted by fax.

QUESTIONS

Questions regarding this RFP are to be directed by e-mail to Sarah Bontrager, Housing and Public
Services Manager, at sbontrager@elkgrovecity.org. Such contact shall be for clarification
purposes only. The City will answer questions on a rolling basis, generally weekly. Material
changes, if any, to the scope of services or proposal procedures will only be transmitted by written
addendum and posted to the City website. Addendums and answers to submitted questions will
be available via the City of Elk Grove website under “Notice” for the RFP announcement.

SCOPE OF WORK

Background

The City currently charges an impact fee on new residential and non-residential development to
support the creation of new affordable housing opportunities. Historically, the proceeds of the
fee have been used primarily to develop new multifamily rental residential housing. In 2014, the
City updated its Affordable Housing Loan Program Guidelines that specify policies related to loan
applications and processing (Attachment A).
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Since the City’s incorporation in 2000, the City has invested about $74 million in the creation of
almost 1,800 rental units affordable to low-income households (for rental units, those earning
less than 60 percent of the area median income). More than half of the City’s existing affordable
housing units are targeted to low-income households (60%), with the remainder being primarily
very low-income (50%) units. Few options exist for extremely low-income households. Vacancy
rates across projects are currently under 2% on average.

Under this RFP, financial assistance may be provided to acquire land and construct multifamily
rental units in the City for the purpose of providing affordable housing to low-income households.
The total value of any project loan associated with this RFP is not expected to exceed S5 million.
The available amount under this RFP is expected to be approximately $8 million. In no event shall
the project loans issued hereunder exceed the uncommitted fund balance in the Affordable
Housing Fund at the time of commitment.

City loans are based on the individual needs of the project, and in all cases are intended to be gap
financing. The developer is expected to seek financing for the project from other state and local
agencies, private investors, and banks.

Requirements
All proposed projects must adhere to the following minimum requirements:

e Projects must adhere to the income restrictions noted below:
o 9% LIHTC financed projects:
= At least 58 percent of the project’s subsidized units must be affordable
to very low-income households (those earning at or below 50 percent of
area median income). Inclusion of extremely low-income units is strongly
encouraged.
= All other subsidized units must be affordable to households earning at or
below 60 percent of the area median income, with the exception of one
to two unrestricted manager units.
o Projects not financed with 9% LIHTC:
= All subsidized units must be affordable to households earning at or below
80 percent of the area median income, with the exception of one to two
unrestricted manager units.
= |nclusion of very low-income and extremely low-income units is strongly
encouraged.

e The developer must have a successful background in the provision of housing to low-
income households, including the associated service component. The project team must
indicate their track record of experience and financial capacity to complete, maintain, and
manage housing projects similar to the one proposed (including size, tenant profile,
affordability profile, financing sources, management and tenant services arrangements,
and other applicable characteristics).

e The project location must be near services, shopping, and transit resources. Projects
proposing to use 9% LIHTC funding or any other funding source with scoring based on
project location must show the number of points the project would receive and the total
number of points available relative to location characteristics, as per the most recent
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application for the funding source.

e The project must include on-site social services providing resident support for no less than
15 hours per week. Such services may include up to 10 hours per week of after-school
programming and/or senior activities.

e The project must offer a repayment schedule that provides for meaningful loan
repayment at the earliest point during the project term.

e The project must be deed-restricted to provide affordable rents and occupancy for a
minimum of 55 years.

Please note that proposals submitted by the March 24, 2021 deadline (for projects pursuing 9%
LIHTC funding in the July 2021 round) must be ready for acquisition and construction activities.
These proposals should not represent projects that are conceptual in nature. These proposals are
intended to clearly state the entire scope and anticipated accomplishments of the housing activity
proposed.

Proposals submitted by the May 19, 2021 deadline may represent projects that are ready for
acquisition and construction activities or those that are conceptual in nature.

Proposals for projects to be constructed on City-owned property will not be accepted; one or
more RFPs for affordable housing projects on City-owned parcels will be released in the future.

Respondents are limited to one proposal per deadline. A proposal for a project not selected from
among the March 24, 2021 submittal may be reframed and resubmitted by the May 19, 2021
deadline.

If a project pursuing 9% LIHTC funding in the July 2021 round is funded, under no circumstances
shall the developer redefine, renegotiate, or otherwise change the scope or the original intent of
the proposal. If, for any purpose, the project is thus redefined with a change in the scope of
purpose or any deviation from the original intent of the proposal, the modified proposal shall be
deemed null and void.

For any other projects funded hereunder, under no circumstances shall the developer redefine,
renegotiate, or otherwise change the scope or the original intent of the proposal without approval
of the City. If, for any purpose, the project is thus redefined with a change in the scope of purpose
or any deviation from the original intent of the proposal, without the requisite City approval, the
modified proposal shall be deemed null and void.

PROPOSAL GUIDELINES AND FORMAT

The following guidelines are provided for standardizing the preparation and submission of
proposals. The intent is to assist respondents in the preparation of their submissions and to assist
the City by simplifying the review process providing standards for comparison of submissions.

Statements submitted in response to this RFP shall include a complete response to the
requirements in this section in the order presented. Statements should be a straightforward
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delineation of the respondent’s capability to satisfy the intent and requirements of this RFP, and
should not contain redundancies and conflicting statements.

Proposals shall be formatted with easy-to-read font size and style, pages shall be numbered, and
individual sections shall be divided for easy identification. Digital submissions shall include
bookmarks for each section.

Proposals shall contain the following information in the order listed:

1. Introductory Letter
The introductory letter should be addressed to:

Sarah Bontrager, Housing and Public Services Manager
City of Elk Grove

8401 Laguna Palms Way

Elk Grove, CA 95758

The letter should state the prime developer and include the developer’'s name, mailing
address, telephone number, and contact name. Respondent shall provide a brief description
of the proposed Project, its location (if known), expected date to begin construction, and
amount of City funding requested. The cover letter shall include a statement acknowledging
the conditions stated in the RFP, making reference to any exceptions contained in the
response, and be signed by an authorized officer of the developer. The developer is
responsible for answering any questions relevant to the proposal and has lead responsibility
relative to the project development and operation as relates to any City funding commitment.

2. Table of Contents
The developer shall insert a comprehensive table of contents denoting Sections 3 through 14
of the proposal as indicated below.

3. Quualifications and Experience
Provide a narrative statement describing all entities responsible for the development and
management of the project (including service providers if applicable), including the following:

a. A description of each firm relevant to the project’s development, construction, and
management. Include information on each firm’s role in the project, and experience
working together on previous projects. Also, note which firm will be the project lead.

b. Identify key staff, including brief resumes that include length of time providing such
services and contact information (including location, phone and e-mail address). The
proposal should indicate each team member’s responsibility for project tasks. Identify
the lead person who will be the primary liaison.

c. For each nonprofit organization involved in the project, provide nonprofit name,
incorporation date and place, affiliated organizations, IRS tax status, annual budget,
and major sources of funding.
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For each entity, the proposal shall include a list of jurisdictions and projects similar to
the one proposed in which the entity has provided such services in the past 5 years.
Projects included shall include the client name and location. At least five examples of
recent, relevant projects shall be provided. For developers, the list should include the
name of the jurisdiction, contact person, phone number, and the approximate
amount of funding received. Respondent must have no record of unsatisfactory
performance with the City or with any other jurisdictions that have contracted with
or provided funding. References may be contacted as a part of the selection process,
and will be asked to comment on work quality and performance.

Show that the developer or joint venture formed by the developer has the
demonstrated ability to secure conventional and/or subsidized financing as any such
financing may be applicable to the project.

4. Project Description
Provide the following information:

Ready to Proceed Projects

a.

Name of project.

Property address and Assessor’s Parcel Number(s), location map, and description of
nearby amenities.

Description of the population served (e.g., family, senior, special needs).

Number of proposed affordable units, proposed affordable rents (and basis for
which), and affordability levels by unit.

Total project costs, total units, and cost per unit.
Applicable project amenities, services, and/or any other relevant project information.

Conceptual site plan, elevations, unit plans, and a description of how the project
design will complement and enhance the surrounding community.

Any market or feasibility studies completed for the project within the last six (6)
months, or indicate if none were completed. (Attach as an appendix.)

Conceptual Projects

a.

Working name of project.

Desired site characteristics, including size of parcel, target locations (may be specific
or map of general area), and nearby amenities.

Description of the population served (e.g., family, senior, special needs).

Number of proposed affordable units, proposed affordable rents (and basis for
which), and affordability levels by unit.
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e. Anticipated total project costs, total units, and cost per unit.
f. Applicable project amenities, services, and/or any other relevant project information.

g. Conceptual site plan, elevations, unit plans, and a description of how the project
design will complement and enhance the surrounding community. Alternately, the
developer may provide this information from a prior, recent project similar to the one
anticipated in this proposal.

h. Any feasibility information or studies supporting the likelihood that the anticipated
project could be constructed. (Attach as an appendix.)

5. Site Control Description/Evidence and Valuation
If proposing by the March 24, 2021 deadline, respondent must have site control (e.g. fee
simple title, long-term leasehold, or purchase option through the date of expected land
closing) for the project, and provide evidence thereof. Include as an appendix any applicable
evidence of site control and a recent appraisal or other evidence of value.

If proposing by the May 19, 2021 deadline, respondents must include the above-noted
information if they have a specific site on which they are proposing to construct a project.
Respondents proposing conceptual projects may indicate this section is not applicable.

6. Project Expected Timeline
Respondent shall prepare a table that explains key project timeline milestones achieved to
date and/or projected in the future. Such table shall include the following at a minimum (or
indicate if not applicable):

Key Prerequisite
Milestone Date Milestone /
Contingency

Obtain site control

Submit application for planning entitlements/approvals

Submit loan application to lender

Environmental review/Phase 1 study

Complete planning entitlement process

Select tax credit investor

Select contractor

Prepare detailed cost estimate

Submit plans and application(s) for plan check and building
permit

Public body approval and TEFRA to apply for bond allocation
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7.

8.

Submit application for bond allocation

Submit application for tax credit allocation

Obtain bond allocation

Obtain tax credit allocation

Obtain approval of construction plans

Obtain construction and permanent loan commitment

Final construction contract

Closing of all financing

Pay impact fees and obtain construction permits

Begin construction

Complete construction

Full lease-up

Zoning and Entitlements

For all proposals where the respondent has site control, provide a narrative that clearly
describes current zoning of the project and entitlement status. Indicate level of
environmental review required of the project and completed to date. Indicate when and
under what conditions upon receipt of entitlements that buildings plans will be submitted and
approved.

Respondents proposing conceptual projects must include a summary of their experience
completing required environmental reviews and project entitlement processes.

Sources and Uses of Funds
Provide a detailed “Sources and Uses table” which clearly states:

a. Each funding source and proposed or committed amount.

b. Detailed use of funds broken down between acquisition, construction, soft costs, and
other cost categories as applicable. Include a statement with regard to the basis for
construction cost estimates and indicate if construction costs are based on prevailing
wage requirements.

c. Atable that identifies sources and uses by funding source.

d. Evidence of funding commitment, for any funds committed.

e. Description of lien position among all funding sources.

f. Detailed contact information for each applicable funding source (such as name, title,
address, phone, email).
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9.

10.

11.

12.

g. Expiration date of any funding commitments.
h. Critical terms and conditions of any funding commitments.

Operating Pro Forma

Submit a cash flow projection including the first fifteen (15) years of the project but also
including the full amortization of all mortgage financing sources. The operating pro forma
shall clearly provide all relevant revenue, operating cost, and financing assumptions.

Low-Income Housing Tax Credits (LIHTC)

If respondent anticipates applying for 9% LIHTC, submit an analysis detailing the project’s tie-
breaker percentage, based on California Tax Credit Allocation Committee (TCAC) guidelines.
In order to provide the City with information on how competitive this new project is and the
likelihood of receiving TCAC funding, provide a narrative describing how this proposed new
development compares to the developments funded in the recent rounds of the 9% LIHTC
awards.

Conflict of Interest Statement

Submit a statement regarding any activities or relationships of the proposer that might create
a conflict of interest for the proposer or the City, and, if such activities or relationships exist,
a description of the facts, legal implications, and possible effects sufficient to permit the City
to appreciate the significance of the conflict and to grant any conflict waiver, if appropriate
and necessary.

Insurance
Submit evidence of ability to insure as stated in Attachment B and summarized below.

SINGLE LIMIT /

YR OCCURRENCE

AGGREGATE ENDORSEMENTS*

Additional Insured
General Liability (1F) $2,000,000 $2,000,000 Waiver of Subrogation
Primary Non Contrib.

L $1,000,000 -

Auto Liability (2E) AT AU Additional Insured

Work Comp (3A) Statutory . .

Employer’s Liability $1,000,000 each Waiver of Subrogation

During Loss Payee

Builder’s Risk (5A) Total value of loan construction until . v .

Waiver of Subrogation
occupancy

Replacement value
Hazard Insurance (7A) of affordable
housing

At occupancy until

. Loss Payee
loan maturity date y

Additional Insured
Umbrella Coverage (8B) $5,000,000 $5,000,000 Waiver of Subrogation

Primary Non Contrib.
*Must be actual endorsements. Typed statements on Certificates of Liability are unacceptable. This is
a summary only. Please refer to Exhibit B for specific requirements.
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13. Exceptions
Note any exceptions to the RFP requirements in their entirety. The City may reject any
requests for modifications to the RFP requirements that were not noted in response to this
RFP.

14. Supportive Information
This section may include graphs, charts, photos, resumes, references, etc. in support of the
respondent’s qualifications and/or project plan.

RFP SCHEDULE
The City anticipates the following schedule for reviewing submitted proposals:

RFP available February 22, 2021

Questions/answers posted online Weekly

Deadline for proposal submissions March 24, 2021 at 4:00pm (9% LIHTC 7/2021)
May 19, 2021 at 4:00pm (other funding)

City Council consideration June 23, 2021 (9% LIHTC 7/2021)
August 25, 2021 (other funding)

The City may revise the schedule as needed.

Prior to City Council consideration, the Affordable Housing Committee (AHC) may select one or
more proposals to move forward to the loan application stage. The AHC may then review the loan
application(s) and recommend that the Council consider a loan for one or more specific projects.
The timeframe for the loan application stage will be determined in coordination with the
developer(s) selected, staff, and the AHC members.

In the event that a loan is recommended, City staff plans to present to the City Council a
Resolution of Conditional Loan Commitment or similar document in order to approve the funding
for an affordable housing project. The Resolution will give the developer an opportunity to apply
for one or more rounds of LIHTC. Unless otherwise approved by the City, the Resolution shall
terminate upon the earlier of 1) denial of award of LIHTC during three consecutive rounds, or 2)
automatically as of December 31, 2022 and shall thereafter have no force or effect.

EVALUATION AND SELECTION CRITERIA

Project Selection Process

In order for projects to be considered for assistance, a proposal consistent with the terms of this
RFP must be submitted. City staff shall review the responses to this RFP for completeness and
evaluate them against the stated criteria. Once the proposal has been determined to be eligible
and complete, it will be reviewed by the AHC for recommended action. The AHC will select one or
more projects to move forward to the loan application stage.

During the loan application stage, the selected developer(s) shall be required to submit a
complete loan application. The loan application will be reviewed and analyzed by City staff to
determine financial feasibility, confirm the request for assistance is reasonable and necessary,
and evaluate whether the project is likely to proceed on a timely basis, among other factors. The
AHC will then consider the loan application and make a recommendation to the City Council
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regarding loan commitment. The AHC may recommend approval of a loan, denial of a loan, or
continued negotiation and collection of information.

If a loan is ultimately approved, it will be evidenced by a Loan Agreement, Promissory Note, Deed
of Trust, Regulatory Agreement, and any other documents deemed necessary by the City.

Proposal Evaluation

Proposals will be evaluated using the five categories listed below, plus four bonus categories. The
following represent the principal selection criteria, which will be considered during the evaluation
process:

Development and Management Capacity (25%)
e Experience developing, owning, and operating affordable housing projects similar to the
one proposed.
e Record of developing successful housing within California and specifically the Sacramento
region.
e Strength, stability, and experience of team members individually and working as a team.
e Assessment by references.

Project Financial Feasibility (25%)

e Status of funds from other sources (such as fee waivers, payment of infrastructure costs,
Low Income Housing LIHTCs, tax-exempt bonds, and lender financing). For conceptual
projects, the developer’s track record of receipt of LIHTC and other funding source will be
considered.

e Cost reasonableness.

e Competitiveness to receive LIHTC (if applicable).

e Amount of per-unit and per-project funding requested.

e Proposed cost savings sharing in a percentage equal to the City’s contribution to the total
project financing.

e Likelihood of the project being constructed within the next 24 months.

Project Design and Community Benefit (25%)

e Project enhances and complements the surrounding neighborhood.

e Project location provides tenants with easy access to major bus routes, shopping, and
social service providers.

e Proposes support services for the low-income residents through a provider with a proven
record of success.

e Offers on-site tenant amenities for low-income residents and surrounding communities
that would not normally be available.

e Site plans and unit plans suitable for targeted population.

For respondents proposing conceptual projects, this factor shall be evaluated based on
information from a prior, recent project similar to the one anticipated in this proposal.

Ability to Meet Community Housing Needs (15%)
e Includes 29%+ of affordable units for extremely low-income households.
AND/OR
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e Includes 58%+ of affordable units for very low-income households.

Project Readiness (10%)
e Evidence of private or public lender commitment to the project.
e 7Zoning or development approval has been obtained or is supported and/or readily
achievable.
e Evidence of clear title, appraised value, and environmental acceptability of the identified
site.
e Preliminary design sketches, site and unit layout, and landscape plan.

For respondents proposing conceptual projects, this factor shall be evaluated based on
information from a prior, recent project similar to the one anticipated in this proposal. Evidence
of clear title, appraised value, and environmental acceptability is not required.

Bonus — Unit Affordability Adjustments (10%)

e Commitment to performing annual income recertifications and adjusting unit
affordability accordingly. In effect, this means that a household initially living in a 30%
AMI unit and whose household income rises to 50% AMI would have their rent adjusted
to the 50% AMI level, and the next available unit would be made available to a household
earning 30% AMI.

e Developer commitment to placing tenant-based Housing Choice Voucher (HCV or Section
8) holders into units with the highest income level (generally 60% units), when such units
are available, and, when such units are not available, adjusting unit affordability as soon
as possible. (This policy is not intended to prioritize HCV holders over other households,
but rather to ensure that the units targeted to households with the lowest incomes are
available to those without HCV subsidy.)

Bonus — Commitment to Addressing Homelessness (5%)
e Commitment to working with the City to address homelessness, including by
implementing a policy moving Elk Grove households experiencing homelessness to the
top of the waitlist for any vacant unit for which they are qualified.

Bonus — Maximizing Funding Sources (5%)
e Usage of funding sources in addition to or in lieu of LIHTC financing and/or a per-unit City
loan of less than $35,000 per affordable unit.

Bonus — Innovation in Project Design (5%)
e Innovation in design or project type, such as a mixed-use development or a project
containing permanent supportive housing.

GENERAL POLICIES

Late Proposals
Proposals arriving after the specified date and time will not be considered, nor will late proposals
be opened. Each respondent assumes responsibility for timely submission of its proposal.

Withdrawal or Modifications of Proposals
Any proposal may be withdrawn or modified by a written request signed by the respondents and
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received by the City Clerk prior to the final time and date for the receipt of proposals. Once the
deadline is past, respondents are obligated to fulfill the terms of their proposal.

Proposal Acceptance and Rejection

The City reserves the right to accept any proposal, to reject any and all proposals, and to call for
new proposals, or dispense with the proposal process in accordance with the Elk Grove Municipal
Code.

Proposal Evaluation and Award

Evaluation will be made on the basis of the weighted scoring as noted in Evaluation and Selection
Criteria section. Proposals shall be evaluated by staff and the Affordable Housing Committee.
One or more developers will be selected to move forward to the loan application stage based on
the strength of their proposal.

No commitment of funds shall be made until such time that a complete loan application has been
submitted and underwritten. The Council shall approve or deny any loan commitment after
considering the recommendation of the AHC.

Nothing herein shall obligate the City to award a contract or loan to any responding developer.

Register with the California Secretary of State:

Unless respondent is a sole proprietorship, respondent must be registered and in good standing
with the California Secretary of State within 14 days following notification of the City’s intent to
prior to execution of final loan documents. Failure to timely register with the Secretary of State
may result in the City awarding the contract to another proposer. Additional information
regarding the registration process may be found on the Secretary of State’s website at:
https://businesssearch.sos.ca.gov/.

Disclosure of Submitted Materials

After selection and execution of the contract(s), (or prior thereto if required by law) all
information and materials provided in each submittal received is subject to disclosure through a
public records request pursuant to the California Public Records Act, or otherwise as may be
required by law. The City, in its sole discretion, may release any submitted materials, regardless
of whether such materials are marked by respondents as confidential or otherwise as protected.

Waiver of Irregularities

The City retains the right, in its sole discretion, to waive any irregularities in proposals that do not
comply with the strict requirements of this RFP, and the City reserves the right to award a contract
to a developer submitting any such non-compliant proposal, all in the City’s sole discretion.

Use of Other Governmental Contracts
The City reserves the right to reject any part or all of any proposals received and utilize other
available governmental contracts.

Qualification/Inspection

Proposals shall only be considered from developers normally engaged in providing the types of
products and services specified herein. By responding to this RFP, the developer consents to the
City’s right to inspect the developer’s facilities, products, personnel, and organization at any time,
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or to take any other action necessary to determine developer’s ability to perform. The City
reserves the right to reject proposals where evidence or evaluation is determined to indicate
inability to perform. The City reserves the right to interview any or all responding developers
and/or to award a contract or loan without conducting interviews.

Federal Requirements

Should any portion of this procurement require the use of Federal funds, all Federal requirements
shall apply and all developers must consent to each certification and assurance, which will be
incorporated into the contract or loan documents.

Performance
It is the intention of the City to acquire products or services as specified herein from a developer
that will give prompt and convenient service.

Term of Agreement

The term of the contract or loan commitment, if awarded, will be for a specific period of time.
The City anticipates the loan commitment to be for a term of not more than 24 months, with any
extensions at the sole option of the City; the City reserves the right to set the term for a period
deemed to be in the best interest of the City.

Service and Support
All developers shall explain how all on-going service and support will be handled by the developer.

Records

The developer shall maintain complete and accurate records with respect to labor costs, material
expenses, and other such information required by City that relates to the performance of services
under any contract or loan agreement. The developer shall maintain adequate records of services
provided in sufficient detail to permit an evaluation of services. All such records shall be
maintained in accordance with generally accepted accounting principles and shall be clearly
identified and readily accessible and in a form acceptable to the City, which the City may specify
and change from time to time. The developer shall provide free access to the representatives of
City or its designees, at reasonable times, to such books and records, shall give City the right to
examine and audit said books and records, shall permit City to make transcripts therefrom as
necessary, and shall allow inspection of all work, data, documents, proceedings, and activities
related to this contract or loan agreement. Such records, together with supporting documents,
shall be maintained for City’s inspection for a period of at least three (3) years after receipt of final
payment.

Insurance Requirements

Attachment B includes the applicable insurance requirements for this project. The proposed
developer must review these requirements closely as changes requested after the proposal
submission deadline may not be allowed.

Agency Discretion, Non-Liability Waivers, and Hold Harmless

The information in this RFP is intended to provide general information regarding the City
affordable housing programs. This information is not intended or warranted to be a complete
statement of all of the information the respondents might be required to ultimately provide.
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This RFP does not commit the City to pay any costs incurred in the preparation of a response. The
City reserves the right to accept or reject any proposal in part or in its entirety. The City reserves
the right to choose any number of qualified proposals. In addition, the City reserves the right to
issue written notice to all participants of any changes in the proposal submission schedule or other
schedules, should the City determine, at its sole discretion, that such changes are necessary.

Loan Terms

In the event that a Resolution of Conditional Loan Commitment is approved by the City Council,
it will be conditioned on, among other things, the agreement of the City and the developer (also
called “Borrower”) on the form of the loan documents (including, but not limited to, a Loan
Agreement, Regulatory Agreement, Promissory Note, Deed of Trust, and Notice of Affordability
Restrictions). Loan terms will be negotiated for each individual project, but will generally include
the following:

e Description of property, including regulated units and project amenities;
e Restrictions requiring the property to be used as affordable housing for a term of at least
55 years;
e |Interest rate of 4%;
e Conditions regarding the disbursement of funds, which will be tied to phases of
completion;
Cost savings sharing provision;
Financial record-keeping and reporting requirements;
Insurance requirements (Attachment B);
Environmental compliance policies;
e Events of default and remedies;
e Repayment plan and policies;
e Management policies and requirements;
e Payment and performance bonding requirements (Attachment C);
e Downward adjustor in the case that any of the proposed affordable units are not
provided, or if more funding than anticipated is received from other sources;
e Timeframe for construction start and completion;
e Quality of work provisions;
e Limitations on property encumbrances and transfers;
e Requirements related to accessibility and non-discrimination;
e Provisions requiring the following:
o Property must have an on-site social service component;
o Compliance with federal and state prevailing wage provisions and licensing
requirements, as applicable;
o Competitive bidding of contracts and subcontracts;
o Payment and performance bonding, in compliance with the templates in Exhibit
&
o City approval of any changes to the Financing Plan, including all construction
change orders over $25,000 and soft costs change orders over $10,000;
o Developer fee limited to 10% of total project cost;
o Property must be rebuilt in the event of damage, and that any insurance proceeds
must be used for that purpose; and
o City approval is required for any changes to the senior loan.
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Any disagreement with, or specific requirements for, these general terms must be discussed in
the proposal.

Sample documents from the City’s recent transactions are available on request; however, the City
shall have the right to design loan documents for this transaction in the manner deemed in the
best interest of the City.

Final Authority
The final approval authority rests solely with the City Council of the City of Elk Grove.
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CITY OF ELK GROVE

Affordable Housing Loan Program Guidelines
April 9, 2014

I. BACKGROUND

The City of Elk Grove’s Affordable Housing Fund (AHF) is supported by a development impact fee
program that provides the financial resources to promote and assist in the development of new
affordable housing in the City. The AHF's revenues come from residential and non-residential
development impact fees paid by project applicants at building permit issuance. Revenues in the AHF
must be used in compliance with Chapters 16.88 and 16.89 of the Municipal Code, which generally allow
provision of loans or grants to support new residential development costs for low-income housing units,
acquisition and rehabilitation of low-income housing units, homeowner downpayment assistance for
low-income households, and other project or programs approved by the Council.

The City’s Affordable Housing Loan Program assists affordable housing developers by providing loans for
development financing. The loans are intended to be “gap” financing. The “gap” is defined as the
difference between total development cost and the maximum potential project funding raised from
private and public sources other than Elk Grove’s AHF.

Thus, the public purpose of the City’s housing loan funds is to provide financial assistance to income-
targeted housing that a for-profit or nonprofit developer cannot secure from non-city sources, helping
to assure financial feasibility of the project.

Il. OVERVIEW OF PROGRAM GOALS

The Affordable Housing Loan Program goals, consistent with the City of Elk Grove’s General Plan
Housing Element, are as follows:

a) Increase the supply of affordable housing through new construction;
b) Ensure long-term affordability of very low- and low-income housing;

c) Encourage the development of well designed, high quality, and energy efficient residential
projects that meet the needs of individuals and families as well as seniors;

d) Maintain quality living environments for residents of assisted affordable developments and
surrounding properties;

e) Support homeownership programs;

f) Support the development of income-restricted apartment and/or single-family development
projects;

g) Encourage the production of the maximum number of units to be in compliance with the state
mandated Regional Housing Needs Allocation (RHNA) requirement, determined by the
Sacramento Area Council of Governments (SACOG) for the City.

h) The current RHNA housing unit goals for the period between 2013 and 2021 are as follows:
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Income Category 2013-2021 RHNA
Extremely Low 1,018
Very Low 1,017
Low 1,427
Moderate 1,377
SUBTOTAL 4,839
Above Moderate 2,563
TOTAL 7,402

GENERAL PROGRAM AND POLICIES

The administration of the Affordable Housing Loan Program shall be guided by the following policies and
procedures:

Whenever the City has accumulated no less than five million dollars ($5,000,000) in AHF fees
available for loans, or such other amount as directed by the Council, the City will issue a
Request for Proposals (RFP) from developers for new projects. The RFP issued at that time will
detail the requirements. Proposal requirements may include, but are not limited to:

i. A project description, including unit count, affordability mix, conceptual site
plan, and elevations.

ii. Project location, including a description of nearby amenities.

iii. Project schedule, including projected dates of financing commitments, land use
approvals, plans and permits, construction, funding draws, and full occupancy.

iv. Preliminary pro forma, showing anticipated project costs and sources of
funding.

v. Project team information, including any experience developing affordable
housing.

Proposals will be due no less than thirty (30) calendar days after the release of the RFP.

All loans are intended to be gap financing; the developer is expected to seek financing for the
project from other state and local agencies, private investors, and banks. Prior to release of an
RFP, the City will consider the timelines and deadline of other state or local agencies that may
be offering loans and grants so developers have an opportunity to also apply for these other
loans and grants.

Proposals will be evaluated by staff and the Affordable Housing Committee (AHC). One or
more developers will be selected to move forward to the loan application stage based on the
strength of their proposal.

Developers must apply for a loan using the City application forms. (Note: The City is unable to
accept new loan applications from proponents of currently funded projects that are not in
compliance with loan terms until any default is remedied by the applicant.)
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e. Applications will be reviewed for completeness and staff will work with the applicant to
identify the items required for completing the loan application. Underwriting will commence
only with complete loan applications. A complete loan application consists of the completed
City application forms, including but not limited to the supporting due diligence documents
listed in Part 2 of the City loan application, “Supplemental Applicant Documents.” Staff will
provide notice to a loan applicant when their application is deemed complete in the form of a
formal letter.

f. Complete loans applications will be underwritten by staff, and underwriting will be completed
in 45 calendar days. If more than one application is submitted, the strengths and weaknesses
of the applications will be considered concurrently by staff and the AHC. If the developer is
faced with internal deadlines for their project, such as land purchase and option
requirements, they must consider the length of the underwriting process by City staff and the
AHC; the City general processing times will not be modified.

g. The underwriting process will include: (1) analysis of project pro-forma, (2) review of due
diligence documents (including third party appraisal reports and market studies), and (3)
negotiation of loan terms.

h. Upon completion of underwriting, staff will submit to the AHC a recommendation which
includes, but is not limited to, one of the following: 1) loan approval, 2) loan denial, or 3) a
recommendation that the developer continue to make additional improvements to their
proposal based on adherence to loan program policies and due diligence. The AHC will
perform an independent review of the loan application, return the loan package to staff with
their recommendation, which includes but is not limited to, 1) continued negotiation and
collection of additional information requested from the developer, 2) a recommendation for
loan approval by the City Council, or 3) a recommendation for denial by the City Council.

i. The AHC will provide its recommendation for a loan application within 60 days of the first
meeting to discuss the loan application. If the AHC does not provide a recommendation to
Council within 60 days, the application will be deemed denied by the AHC and will be
automatically forwarded to City Council for action.

j. The AHC recommendations are not restricted by available funding but need to acknowledge in
their recommendation any priority preferences.

k. The AHC will consider for each proposed project the merits of the financing plan as well as
conformance with the City’s General Plan (including, but not limited to, H3 - Action 1 of the
Housing Element).

I.  The AHC will be scheduled to meet on an as-needed basis, at a date and time determined
possible by the Committee and staff. The meeting day and time will be posted by the City
Clerk.

IV. LOAN FUNDING CRITERIA
Project Readiness
Project readiness will be a critical factor, as indicated by site control, supporting documentation of other

private/public financial commitments and managing partners, and the status of the project’s
development review applications.
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a. Site Control. The property must be in the control of the applicant, through fee title, executed
lease agreement or lease option of sufficient length, an enforceable contingent purchase and
sale agreement or option, or a development and disposition agreement with a public agency.

b. Project Development Review. Loan applicants are required to submit a complete development
review application(s), as determined by the City’s Planning Department, concurrently or within
one week after submitting a complete affordable housing loan application. The development
review applications contain critical information about the proposed project that must be
considered concurrently with the loan application.

c. Construction Completion. Projects are expected to be constructed within a short timeframe of
receipt of development and affordable housing loan approvals.

Units and Subsidies
a. Projects that maximize the development of affordable units per site are preferred.

b. Projects located in close proximity to services, shopping, and public transportation are
encouraged.

c. The proposed project must have the purpose of addressing the goals outlined in the City’s
Housing Element and the RHNA requirements determined by SACOG.

Use of City Funds

Loans provided by the City are intended to be gap financing. Upon review of a loan application, the City
will consider the developer’s ability to leverage City funds, maximizing other sources of project
financing. Loan applicants are responsible for preparing accurate development cost estimates for their
proposed projects. While the City can assist with questions related to City administered development
impact fees, the loan applicants are responsible for estimating all project costs, including fees charged
by all entities. If applicants submit a loan application early in the development process, where cost
estimates may be premature or not fully known, the City cannot be responsible for assisting in
additional gap financing if any project costs, including fees, increase at a later time. Should project costs
increase after City affordable housing loan approval, applicants are expected to secure revenue to cover
such increased costs from non-City sources.

Conditional Funding Commitments and Funding Commitments

Conditional Funding Commitments. Loan applicants for projects which have not yet received approval of
their complete development review application may obtain a Conditional Funding Commitment from
the City Council. With a Conditional Funding Commitment, the loan amount and loan terms approved
for a proposed project will be reserved for a maximum period of nine months, then the loan
commitment automatically terminates if project entitlements are not received. Without exception, all
conditions must be met to later obtain a Funding Commitment. Should the applicant need additional
time to secure development entitlements, a written letter of request documenting the reasons for the
request must be submitted to the City Planning Director for consideration for an additional three
months to complete the entitlement process and execute the City loan. If a loan applicant seeks further
consideration from the City of their proposed project after termination of a Conditional Funding
Commitment, the loan applicant must submit a new loan application. After project entitlements are
received, draft loan documents will be prepared by City staff for City Council review.
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Funding Commitments. The City Council will provide a Funding Commitment after development review
entitlements are approved. The City loan documents associated with a proposed project will be
reviewed by City Council at the time a Funding Commitment is approved.

Project Performance

Agreements for bond financing, investor equity, and other financial sources for project development
must be fully executed/closed within four months of obtaining a Funding Commitment, or such other
time as designated by the Council on a case-by-case basis. The City loan closing will be concurrent with
the primary source of financing (i.e. first mortgage lender) for the project.

All building permits for a proposed project must be obtained within twelve months of obtaining a
Funding Commitment. An extension of up to an additional three months may be allowed with written
approval of the Planning Director, based upon documentation of circumstances beyond the control of
the applicant.

Long Term Affordability Requirements
All housing units financed by the AHF carry affordability restrictions into the future. These affordability
restrictions shall exist for a minimum of 55 years.

Loan Repayment
City loans are expected to be repaid. The City will prioritize projects that can provide repayment at the
earliest point during the loan term.

V. MATERIAL CHANGES TO THE PROJECT

Any changes to the project’s design, including but not limited to unit count, unit configuration, etc.
and/or financial structure subsequent to the submittal of the loan application and/or receipt of a
Conditional Funding Commitment and Funding Commitment must receive City’s prior written approval;
otherwise, the City reserves the right to withdraw its loan commitment. Requests for material changes
to a project must be submitted in writing to the City Manager, and a written approval would be
provided on a discretionary basis.

A reduction in the number of affordable units proposed by a developer by one or more units is
considered a material change, since a dollar subsidy is associated with each affordable unit. If a
reduction to the affordable housing unit count is requested by the developer subsequent to receipt of a
Conditional Funding Commitment or Funding Commitment, a pro-rata downward adjustment to the
total loan amount, equivalent to the dollar subsidy associated with each affordable unit, will be applied.
The City Manager may waive applicable downward adjustments to the loan amount for extraordinary
conditions associated with a project.

VI. PROPERTY MANAGEMENT

a. Management Plan. A comprehensive management plan must be approved by the City prior to loan
closing. The plan must address rental procedures, maintenance schedule and standards, eviction
procedures, and overall day-to-day operations including safety and security. The loan agreement will
specify all the provisions to be included in the management plan. The City requires approval of the
management firm 1) as part of the Funding Commitment process and 2) upon any subsequent
change.
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b. Project Operating Reports. In order to monitor the operating condition of projects in receipt of City
financial assistance, the City requires receipt of the project’s annual audited financial statement,
consistent with generally accepted accounting principles (GAAP), including the balance, deposits,
and withdrawals from the replacement reserves and operating reserves. The City also requires that
project quarterly financial statements and rent rolls be provided by loan recipients.

c. Property Inspections. The City will have the right to perform property inspections of all projects
financed with City funds one or more times during a calendar year. Only properties with operational
issues are likely to have multiple City property inspections in a calendar year.
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ATTACHMENT B
INSURANCE REQUIREMENTS

Prior to commencement of any work on the Project and continuing until issuance of a
Certificate of Occupancy, Borrower and all contractors working on behalf of Borrower shall
provide to the City proof of, and maintain in full force and effect at all times until the
issuance of a Certificate of Occupancy, at its sole cost and expense, policies of insurance as
set forth herein. Borrower and all contractors shall comply with all reporting and other
provisions of the policies of insurance as set forth herein including, but not limited to, timely
reporting of claims and suits, and fulfillment of self-insured retentions.

1. General Liability:

a. Comprehensive general liability insurance including, but not limited to, protection
for claims of bodily injury and property damage liability, personal and advertising
injury liability, and product and completed operations liability.

b. Coverage shall be at least as broad as Insurance Services Office Commercial
General Liability coverage form CG 0001 (occurrence).

Claims-made coverage is not acceptable.
d. The limits of liability shall not be less than:
Each occurrence: Two Million Dollars ($2,000,000)

Products & Completed Operations: Two Million Dollars ($2,000,000)
Personal & Advertising Injury: Two Million Dollars ($2,000,000)

2. Umbrella Liability Policy
a. The policy must follow form of the underlying general liability policies.
b. The limit of liability shall not be less than $5,000,000 per occurrence.

3. Automobile Liability:

a. Automobile liability insurance providing protection against claims of bodily injury
and property damage arising out of ownership, operation, maintenance, or use of
owned, hired, and non-owned automobiles.

b. Coverage shall be at least as broad as Insurance Services Office Automobile
Liability coverage form CA 0001, symbol 1 (any auto).

c. The limits of liability per accident shall not be less than:
Combined Single Limit One Million Dollars ($1,000,000)

d. If general liability coverage, as required above, is provided by the Commercial
General Liability form, the automobile liability policy shall include an endorsement
providing automobile contractual liability.

4. Worker's Compensation

a. Worker's Compensation Insurance, with coverage as required by the State of
California (unless the Borrower is a qualified self-insurer with the State of
California), and Employers Liability coverage. The Borrower shall execute a
certificate in compliance with Labor Code Section 1861, on the form provided in
Exhibit E.
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Employer’s Liability Coverage shall not be less than the statutory requirements.

If an injury occurs to any employee of the Borrower for which the employee or his
dependents, in the event of his death, may be entitled to compensation from the
City under the provisions of the Acts, for which compensation is claimed from the
City, there will be retained out of the sums due the Borrower under this
Agreement, an amount sufficient to cover such compensation as fixed by the Acts,
until such compensation is paid or it is determined that no compensation is due.
If the City is required to pay such compensation, the amount so paid will be
deducted and retained from such sums due, or to become due to the Borrower.
The insurer shall agree to waive all rights of subrogation against the City, its
officers, officials, and employees for losses arising from work performed by the
Borrower.

Builder’s Risk

a.

Builder's Risk "Special Form" Completed Value upon the entire project which is the
subject of this Agreement, including completed work and work in progress.

The policy or policies of insurance shall name the Borrower and the City, its
officials, officers, employees, agents, and volunteers as insureds as loss payees as
their respective interests may appear.

The Policy shall include an insurer’s waiver of subrogation rights in favor of the
Borrower and the City, its officials, officers, employees, agents, and volunteers.
Such insurance may have a deductible clause, but the amount of the deductible
shall be subject to the approval of the City.

In no event shall the Builder's Risk Coverage be less than the total value of the
Agreement.

Borrower shall comply with all insurance requirements and shall not permit any
condition to exist on the Property that would invalidate any part of any insurance
coverage that this Instrument requires Borrower to maintain.

In the event of loss, Borrower shall give immediate written notice to the insurance
carrier and to City.

The policy’s deductible shall not exceed Fifty Thousand Dollars ($50,000).

Upon issuance of a Certificate of Occupancy and continuing until the maturity date of the

Loan, Borrower shall provide to the City proof of, and maintain in full force and effect at all
times until the maturity date of the Loan, at its sole cost and expense, policies of insurance
as set forth herein:

1.

General Liability:

a.

Comprehensive general liability insurance including, but not limited to, protection
for claims of bodily injury and property damage liability, personal and advertising
injury liability and product and completed operations liability.

Coverage shall be at least as broad as Insurance Services Office Commercial
General Liability coverage form CG 0001 (occurrence).

Claims-made coverage is not acceptable.
The limits of liability shall not be less than:
Each occurrence: Two Million Dollars ($2,000,000)
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Products & Completed Operations: Two Million Dollars ($2,000,000)
Personal & Advertising Injury: Two Million Dollars ($2,000,000)

2.  Umbrella Liability Policy

a.
b.

The policy must follow form of the underlying general liability policies.
The limit of liability shall not be less than $5,000,000 per occurrence.

3. Automobile Liability:

a.

a.

Automobile liability insurance providing protection against claims of bodily injury
and property damage arising out of ownership, operation, maintenance, or use of
owned, hired, and non-owned automobiles.

Coverage shall be at least as broad as Insurance Services Office Automobile
Liability coverage form CA 0001, symbols 7, 8, and 9 (owned, hired, and non-
owned autos).

The limits of liability per accident shall not be less than:
Combined Single Limit One Million Dollars ($1,000,000)
If general liability coverage, as required above, is provided by the Commercial

General Liability form, the automobile liability policy shall include an endorsement
providing automobile contractual liability.

Worker's Compensation

Worker's Compensation Insurance, with coverage as required by the State of
California (unless the Borrower is a qualified self-insurer with the State of
California), and Employers Liability coverage. The Borrower shall execute a
certificate in compliance with Labor Code Section 1861, on the form provided in
Exhibit A.

Employer’s Liability Coverage shall not be less than One Million Dollars
($1,000,000).

If an injury occurs to any employee of the Borrower for which the employee or the
employee’s dependents, in the event of the employee’s death, may be entitled to
compensation from the City under the provisions of the Acts, for which
compensation is claimed from the City, there will be retained out of the sums due
the Borrower under this Agreement, an amount sufficient to cover such
compensation as fixed by the Acts, until such compensation is paid or it is
determined that no compensation is due. If the City is required to pay such
compensation, the amount so paid will be deducted and retained from such sums
due, or to become due to the Borrower.

The insurer shall agree to waive all rights of subrogation against the City, its
officers, officials, and employees for losses arising from work performed by the
Borrower.

5. Hazard/Property Insurance

a.

Property/Hazard insurance on the Project, including improvements and personal
property now existing or hereafter located on the Project, insured against all risks
of loss including but not limited to fire, windstorm, vandalism, malicious mischief
and allied perils, general boiler and machinery coverage, and business interruption
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including loss of rental value insurance for the Project with extra expense
insurance.

If City so requires, such insurance shall also include sinkhole insurance, mine
subsidence insurance, earthquake insurance, and, if the Project does not conform
to applicable zoning or land use laws, building ordinance or law coverage. In the
event any updated reports or other documentation are reasonably required by
City in order to determine whether such additional insurance is necessary or
prudent, Borrower shall pay for all such documentation at its sole cost and
expense.

If any of the Project is located in an area identified by the Federal Emergency
Management Agency (or any successor to that agency) as an area having special
flood hazards, Borrower shall insure such improvements against loss by flood.

Borrower acknowledges and agrees that City’s insurance requirements may
change from time to time throughout the term of the Indebtedness.

The policy shall be written on a full replacement value basis and shall name City as
loss payee as its interest may appear. The full replacement value of the Project to
be insured shall be determined by the company issuing the policy at the time the
policy is initially obtained. Not more frequently than once every two (2) years,
either the operator or the City shall have the right to notify the other party that it
elects to have the replacement value re-determined by the insurance company.

Borrower shall comply with all insurance requirements and shall not permit any
condition to exist on the Project that would invalidate any part of any insurance
coverage that this Instrument requires Borrower to maintain.

In the event of loss, Borrower shall give immediate written notice to the insurance
carrier and to City.

The policy’s deductible shall not exceed Fifty Thousand Dollars ($50,000).

Prior to commencement of any work on the Project and continuing until the maturity date

of the Loan, Borrower and all contractors working on behalf of Borrower shall abide by the
following:

1. All general and auto liability policies required by this Agreement shall contain the
following provisions and endorsements:

a.

The City, its officers, officials, employees, agents and volunteers shall be covered
and specifically named as additional insured as respects liability arising out of
activities performed by or on behalf of the Borrower, products and completed
operations of the Borrower, premises owned, occupied, or used by the Borrower,
or automobiles owned, leased, hired, or borrowed by the Borrower on a separate
endorsement acceptable to the City.

The insurer shall agree to waive all rights of subrogation against the City, its
officers, officials, employees, and volunteers for losses arising from work
performed by the Borrower.

The policy shall contain no special limitations on the scope of coverage afforded
to the City, its officials, employees, agents or volunteers.

Any insurance or self-insurance maintained by the City, its officers, officials,
employees or volunteers shall be in excess of the Borrower’s insurance and shall
not contribute with it, to the payment or satisfaction of any defense expenses, loss
or judgment.
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10.

11.

Acceptability of Insurers: Insurance is to be placed with insurers with a Bests' rating of
no less than A:VII.

Any deductibles, aggregate limits, pending claims or lawsuits that may diminish the
aggregate limits, or self-insured retention(s), must be declared to, and approved by,
the City.

The Borrower shall furnish the City with certificates of insurance and original
endorsements or insurance binders, signed by a person authorized by the insurer to
bind coverage on its behalf, evidencing the coverage required by this Agreement. At
anytime at the written request of the City, Borrower agrees to furnish a duplicate
original or certified copy of each required policy including the declaration pages,
conditions, provisions, endorsements, and exclusions.

The City, at its discretion, may increase the amounts and types of insurance coverage
required hereunder at any time during the term of the Agreement by giving 30 days
written notice.

The Borrower shall serve the City notice, in writing by certified mail, within 2 days of
any notices received from any insurance carriers providing insurance coverage under
this Agreement that concern the suspension, voidance, cancellation, termination,
reduction in coverage or limits, non-renewal, or material changes of coverage proposed
or otherwise.

If the Borrower fails to procure or maintain insurance as required by this section, and
any Supplementary Conditions, or fails to furnish the City with proof of such insurance,
the City, at its discretion, may procure any or all such insurance. Premiums for such
insurance procured by the City shall be deducted and retained from any sums due the
Borrower under the Agreement.

Failure of the City to obtain such insurance shall in no way relieve the Borrower from
any of its responsibilities under the Agreement.

The making of progress payments to the Borrower shall not be construed as relieving
the Borrower or its agents of responsibility for loss or direct physical loss, damage, or
destruction occurring prior to final acceptance by the City.

The failure of the City to enforce in a timely manner any of the provisions of this section
shall not act as a waiver to enforcement of any of these provisions at any time during
the term of the contract.

The requirement as to types, limits, and the City’s approval of insurance coverage to be
maintained by Borrower are not intended to, and shall not in any manner, limit or
qualify the liabilities and obligations assumed by Borrower under the Contract.
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EXHIBIT A
Certificate of Compliance With Labor Code § 3700, Release and Indemnification
The undersigned, on behalf of and as the duly certified representative of Borrower, certifies as

follows:

1. Borrower is aware of the provisions of Section 3700 of the Labor Code which require every
employer to be insured against liability for workers’ compensation or to undertake self-
insurance in accordance with the provisions of that code, and Borrower has complied or will
comply with such provisions before commencing the performance of the work of this
contract. (Cal. Labor Code §§1860, 1861.)

2. Should Borrower fail to secure Workers’ Compensation coverage as required by the State of
California, Borrower shall release, hold harmless, defend and indemnify City of Elk Grove
from and against any damage, liability, claim, cause of action and any other loss, including
without limitation, court costs, reasonable attorney’s fees and costs resulting from any
failure to take and/or maintain Workers’ Compensation insurance as required by law. The
provisions of this Exhibit shall survive termination, suspension and/or completion of this
Contract. It is further understood and agreed that this release and assumption of risk is to
be binding on Borrower’s successors, heirs and assigns.

BORROWER

By:

Date:

Name:

Title:
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ATTACHMENT C
PAYMENT AND PERFORMANCE BOND TEMPLATES

FAITHFUL PERFORMANCE BOND

KNOW ALL MEN BY THESE PRESENTS:

THAT, WHEREAS, the City of Elk Grove, hereinafter designated as the “City”, and
(hereinafter designated as “Principal”) have entered into an
agreement whereby Principal agrees to install and complete certain designated improvements, which
said agreement is identified as Affordable Housing Loan Agreement, Development Loan for
Affordable Housing Project (S ) (“Agreement”), and is hereby
referred to and made a part hereof; and

WHEREAS, said Principal is required under the terms of said agreement to furnish a bond for
the faithful performance of said agreement;

NOW, THEREFORE, we, , as Principal, and
(corporate surety), a corporation organized and existing under
the laws of the State of , and duly authorized to transact business under the

laws of the State of California, as Surety, are held and firmly bound unto the City of Elk Grove
hereinafter called (“City”), in the penal sum of
dollars ($ ) lawful money of the United States, said sum being not less than one hundred
(100) percent of the total Agreement amount, for the payment of which sum well and truly to be
made, we bind ourselves, our heirs, executors, administrators, and successors, jointly and severally,
firmly by these presents.

THE CONDITION OF THIS OBLIGATION IS SUCH, THAT, if the above bounded Principal, his or
its heirs, executors, administrators, successors or assigns, shall in all things stand to and abide by, and
well and truly keep and perform the covenants, conditions, and agreements in the Agreement and
any alterations thereof made as therein provided, on his or their part, to be kept and performed at
the time and in the manner therein specified, and in all respects according to their true intent and
meaning, and shall indemnify and save harmless the City, its officers and agents, as therein stipulated,
then this obligation shall become null and void; otherwise it shall be and remain in full force and
virtue.

As a condition precedent to the satisfactory completion of the Agreement, the above
obligation in said amount shall hold good for a period of one (1) year after the completion and
acceptance of the said work, during which time if the above bounded Principal, his or its heirs,
executors, administrators, successors or assigns shall fail to make full, complete, and satisfactory
repair and replacements or totally protect the City from loss or damage made evident during said
period of one year from the date of acceptance of said work, and resulting from or caused by defective
materials or faulty workmanship in the prosecution of the work done, the above obligation in the said
sum shall remain in full force and effect. However, anything in this paragraph to the contrary
notwithstanding, the obligation of the Surety hereunder shall continue so long as any obligation of
the Principal remains.

And the Surety, for value received, hereby stipulates and agrees that no change, extension of
time, alteration or addition to the terms of the Agreement or to the work to be performed thereunder
or the specifications accompanying the same shall, in any way, affect its obligations on this bond and
it does hereby waive notice of any such change, extension of time, alteration, or addition to the terms
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of the Agreement or to the work or the specifications. Said Surety hereby waives the provisions of
Sections 2819 and 2845 of the Civil Code of the State of California.

In the event suit is brought upon this bond by the City and judgment is recovered, the Surety
shall pay all costs incurred by the City in such suit, including reasonable attorney’s fees to be fixed by
the Court.

IN WITNESS WHEREOF, we have hereunto set our hands and seals this ___ day of
20
Principal:
Name of Surety By:
Address of Surety (Print Name & Title)
and
Telephone No. of Surety By:
By:
Attorney-in-Fact (Print Name &Title)

NOTE: If Principal is a Partnership, all partners must execute Bond.

IMPORTANT: Surety companies executing bonds must appear on the Treasury Department’s most
current list (Circular 570 as amended) and be authorized to transact business in California.

NOTICE: The signature of the Surety on this bond must be acknowledged before a notary public, and
this bond must be accompanied by evidence of the signatory’s appointment as attorney in fact and
authority to bind the Surety.

MANDATORY: The Surety shall be authorized and licensed by the California Insurance Commissioner
as an “admitted surety insurer.” (See Cal. Code Civ. Proc. § § § 995.310, 995.311, 995.320)

APPROVAL: Bonds must be approved by the City. In order to verify the status of the Surety as an
admitted surety, the Surety shall provide the City with at least one of the following: (1) a print-out of
information from the web-site of the Department of Insurance confirming the Surety is an admitted
surety insurer and attaching it to the bond; or (2) a certificate from the Sacramento County Clerk that
the certificate of authority of the Surety has not been surrendered, revoked, cancelled, annulled or
suspended and confirming that the Surety is an admitted surety and attaching the certificate to the
bond. (See Cal. Code Civ. Proc. Code § 995.311).
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PAYMENT BOND
KNOW ALL MEN BY THESE PRESENTS:

THAT, WHEREAS, the City of Elk Grove, hereinafter designated as the “City”, and
(hereinafter designated as “Principal”) have entered into an
agreement whereby Principal agrees to install and complete certain designated improvements, which
said agreement is identified as Affordable Housing Loan Agreement, Development Loan for
Affordable Housing Project ($ ) (“Agreement”), and is hereby
referred to and made a part hereof; and

WHEREAS, under the terms of said Agreement, Principal is required before entering upon the
performance of the work, to file a good and sufficient payment bond with the City of Elk Grove to
secure the claims to which reference is made in Division Fourth, Part 6, Title 3, Chapter 5 of the Civil
Code of the State of California.

NOW, THEREFORE, we, , as Principal, and

, a corporation organized and existing under the laws of the State

of , and duly authorized to transact business under the laws of the State of
California, as Surety, are held and firmly bound unto the City, in the sum of
dollars ($ ), said sum being not

less than one hundred (100) percent of the total Agreement amount payable by the City, under the
terms of the Agreement, for which payment well and truly to be made, we bind ourselves, our heirs,
executors, administrators, and successors, jointly and severally, firmly by these presents.

THE CONDITION OF THIS OBLIGATION IS SUCH, THAT, if the Principal, his or its heirs,
executors, administrators, successors and assigns or subcontractors shall fail to pay for any materials,
provisions, goods or other supplies or teams, implements or machinery used in, upon, for or about
the performance of the Work contracted to be done, or shall fail to pay for any work or labor thereon
of any kind, or shall fail to pay any persons named in Civil Code section 9100, or shall fail to pay for
amounts due under the Unemployment Insurance Code with respect to such work or labor as required
by the provisions of Division Fourth, Part 6, Title 3, Chapter 5 of the Civil Code, or shall fail to pay for
any amounts required to be deducted, withheld, and paid over to the Employment Development
Department from the wages of employees of the Principal and subcontractors pursuant to Section
13020 of the Unemployment Insurance Code with respect to such work or labor, and provided that
the claimant shall have complied with the provisions of that Code, the Surety or Sureties hereon will
pay for the same in amount not exceeding the sum specified in the Agreement, otherwise the above
obligation shall be void. In case suit is brought upon this bond, the Surety shall pay all court costs,
expenses and reasonable attorney’s fee to the prevailing party to be fixed by the court.

This bond shall inure to the benefit of any and all persons, companies and corporations
entitled to file claims under Section 9100 of the Civil Code, so as to give a right of action to them or to
their assigns in any suit brought upon this bond.

And the Surety, for value received, hereby stipulates and agrees that no change, extension of
time, alteration or addition to the terms of the Agreement or to the Work to be performed thereunder
or the specifications accompanying the same shall in any way affect its obligation on this bond, and it
does hereby waive notice of any such change, extension of time, alteration or addition to the terms
of the Principal to the work or to the specifications.
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IN WITNESS WHEREOF, we have hereunto set our hands and seals this day of

20

Principal:

Name of Surety By:

Address of Surety (Print Name & Title)
and

Telephone No. of Surety By:

By:

Attorney-in-Fact (Print Name &Title)

NOTE: If Principal is a Partnership, all partners must execute Bond.

IMPORTANT: Surety companies executing bonds must appear on the Treasury Department’s most
current list (Circular 570 as amended) and be authorized to transact business in California.

NOTICE: The signature of the Surety on this bond must be acknowledged before a notary public, and
this bond must be accompanied by evidence of the signatory’s appointment as attorney in fact and
authority to bind the Surety.

MANDATORY: The Surety shall be authorized and licensed by the California Insurance Commissioner
as an “admitted surety insurer.” (See Cal. Code Civ. Proc. § § § 995.310, 995.311, 995.320)

APPROVAL: Bonds must be approved by the City. In order to verify the status of the Surety as an
admitted surety, the Surety shall provide the City with at least one of the following: (1) a print-out of
information from the web-site of the Department of Insurance confirming the Surety is an admitted
surety insurer and attaching it to the bond; or (2) a certificate from the Sacramento County Clerk that
the certificate of authority of the Surety has not been surrendered, revoked, cancelled, annulled or
suspended and confirming that the Surety is an admitted surety and attaching the certificate to the
bond. (See Cal. Code Civ. Proc. Code § 995.311).
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FLK GROVE

QUESTIONS AND ANSWERS
AFFORDABLE HOUSING PROJECTS RFP
Updated March 24, 2021

Is there a list of properties in the City that are available for development? Or, is this just meant for
projects that are already in progress?

The City maintains a list of properties that are zoned for multifamily development and used to meet the
City's lower-income Regional Housing Needs Allocation (RHNA), in coordination with the Housing
Element of the General Plan. As a part of the Housing Element underway now, the City has also identified
a number of candidate sites that may be rezoned for multifamily housing; however, there is no guarantee
any of the noted sites will actually be rezoned. There is an interactive map showing the existing
multifamily sites (E-xx) and candidate sites (C-xx).

The RFP allows for proposals both on projects that may already be in progress and projects that are
conceptual in nature at this point (i.e., do not have a site identified).

Is the developer fee maximum calculated at 10% of total cost or the cash out limit?
The developer fee is limited to 10% of the total development costs (less the fee itself).

Is the City loan interest only and is it residual receipts only?

The City negotiates loan terms on a case-by-case basis after review of the project’'s pro forma and other
financial information, and considering requirements of other agencies providing subsidy. Recent loans
have been structured as residual receipts or residual receipts with a minimum fixed annual payment,
which typically escalates over time.

Does net zero count as Innovation in Project Design for bonus points?
Yes, provided it has a benefit to residents that isn't negated by charging higher rents than in a non-net-
zero project.

NEW - May a nonprofit be named as a partner in more than one application with different
developers in response to the City of Elk Grove RFP?
Yes, this is acceptable.


https://elkmap.maps.arcgis.com/apps/instant/minimalist/index.html?appid=854b859889414b4da63e59b0daee0bc4

CITY OF

ELK GROVE

PROUD HERITAGE. BRIGHT FUTURE

QUESTIONS AND ANSWERS
AFFORDABLE HOUSING PROJECTS RFP
Updated May 17, 2021

Is there a list of properties in the City that are available for development? Or, is this just meant for
projects that are already in progress?

The City maintains a list of properties that are zoned for multifamily development and used to meet the
City’'s lower-income Regional Housing Needs Allocation (RHNA), in coordination with the Housing
Element of the General Plan. As a part of the Housing Element underway now, the City has also identified
a number of candidate sites that may be rezoned for multifamily housing; however, there is no guarantee
any of the noted sites will actually be rezoned. There is an interactive map showing the existing
multifamily sites (E-xx) and candidate sites (C-xx).

The RFP allows for proposals both on projects that may already be in progress and projects that are
conceptual in nature at this point (i.e., do not have a site identified).

Is the developer fee maximum calculated at 10% of total cost or the cash out limit?
The developer fee is limited to 10% of the total development costs (less the fee itself).

Is the City loan interest only and is it residual receipts only?

The City negotiates loan terms on a case-by-case basis after review of the project’s pro forma and other
financial information, and considering requirements of other agencies providing subsidy. Recent loans
have been structured as residual receipts or residual receipts with a minimum fixed annual payment,
which typically escalates over time.

Does net zero count as Innovation in Project Design for bonus points?
Yes, provided it has a benefit to residents that isn't negated by charging higher rents than in a non-net-
zero project.

May a nonprofit be named as a partner in more than one application with different developers in
response to the City of Elk Grove RFP?
Yes, this is acceptable.

Have you made an award to a 9% project and if so — for how much of $8 million? How much
funding is expected to be available for projects submitted by the May 19 deadline?

The Affordable Housing Committee selected a 9% tax credit project requesting a $4 million City loan to
move forward to the application stage. While those funds are not yet committed, it is likely they will be,
leaving about $4 million in available funding for projects submitted in phase 2 of the RFP (May 19
deadline).


https://elkmap.maps.arcgis.com/apps/instant/minimalist/index.html?appid=854b859889414b4da63e59b0daee0bc4
https://elkmap.maps.arcgis.com/apps/instant/minimalist/index.html?appid=854b859889414b4da63e59b0daee0bc4

Q and A — Affordable Housing Projects RFP 20f3
May 17, 2021

On page 15 of the RFP, it states that a “Developer Fee is limited to 10% of project cost”. Does that
provision apply to a 4% Tax Credit and Bond transaction as well? It would be extremely helpful,
and efficient, if the RFP allowed for the developer fee calculation to be consistent with
TCAC/CDLAC guidelines, particularly on a 4% execution. As | am sure you are aware, maintaining
that consistency with TCAC/CDLAC guidelines in this instance would allow for the injection of
additional tax credit equity into the project, thus reducing a project’s reliance on local subsidies. If
this is not your intent, can you please share the specific rational as to why the developer fee
calculation would not be consistent with TCAC/CDLAC on a 4% execution?

The provision applies to projects receiving City loans regardless of their financing structure. You may show
a higher developer fee if the portion over the 10% maximum is foregone.

Is there a cap on the amount of subsidy that can be requested? If so, what is that cap? For
example, if the City has a $5m cap because that is the amount of funds it currently has available,
can a project request $5.5m in support, with the understanding that the remaining $500k would
not be disbursed to the awardee until those fund have been collected by the City though it
affordable housing fee?

There is not a specific cap on the amount of loan funding that can be requested; however, per the RFP, “In
no event shall the project loans issued hereunder exceed the uncommitted fund balance in the Affordable
Housing Fund at the time of commitment.” The time of commitment may be somewhat negotiable, and
would likely be later for conceptual proposals than for those submitted with specific sites in mind.

Note that the City owns multiple sites on which it plans to partner with developers to construct affordable
housing within the next 2-3 years. (These sites are not a part of the current RFP.) Future fees revenues will
likely be substantially devoted to supporting these City-owned sites.

Do projects in Elk Grove have Article 34 authority either from City or County?
The City has remaining Article 34 authority under the 2004 ballot measure.

The RFP asks that we submit evidence of ability to insure. What form of evidence is the City
looking for? Insurance certificates? Letter from our CFO or CEO stating that we can meet the RFP’s
insurance requirements?

A letter from the proposer’'s CEO, CFO, or insurance agent stating that the proposer can and will meet the
RFP’s insurance requirements is acceptable. Please note in the letter any exceptions necessary.

Can you tell me the balance of the City's Affordable Housing Fund as of this date?

The balance in the Affordable Housing Fund is approximately $24.3 million. However, much of that
amount is committed to existing projects, land acquisitions, homebuyer assistance programs, and gap
financing for projects to be built on City-owned land. Staff estimated that about $8 million would be
available under this RFP, and the Affordable Housing Committee selected a 9% tax credit project
requesting a $4 million City loan to move forward to the application stage. This leaves about $4 million
available at this time.

Regarding the developer fee limitation, would the City consider a 4% tax credit/bond project
where the portion of the developer fee over 10% of the project is deferred as opposed to
foregone?

The City will consider projects that have developer fees consistent with TCAC/CDLAC regulations,
including projects where the amount of the developer fee in excess of $2,500,000 plus $20,000 for each



Q and A — Affordable Housing Projects RFP 3o0f3
May 17, 2021

unit in excess of 100 is deferred or contributed as equity to the project. Developers are strongly
encouraged to contribute the excess fee as equity to the project.

NEW - Can you provide clarification on PDF submissions having to be ADA compliant?

ADA compliance means the City makes every effort to make information accessible to those with
disabilities. This includes those who are visually and audibly impaired. The PDF document has to be
machine readable for text to voice purposes and the text must be searchable. Sometimes, depending
on the program or method someone is using to convert their source document to a PDF, the
document gets saved as a picture rather than as a fully machine-readable document. Attached is a
document to further explain.



How to make PDFs

ADA compatible CIVICENGAG E

Why?
What's the fuss? Why make PDFs, or any other document for that matter, ADA (Americans with
Disabilities Act) compliant?
* It's the law. As a state and federally funding institution, you must comply with Section 508,
Section 504 and the ADA.
e It can also affect a program’s accreditation standing.
* It's the right thing to do.

What is ADA Compliance?

Simply stated, ADA compliance means we make every effort to make information accessible to those with
disabilities. This includes those who are visually and audibly impaired.

What makes a PDF “ADA Compliant”?
Some of the features of an ADA compliant PDF include:
* Searchable text
o Note: PDFs created by scanning may actually be an image and not searchable text.
* Images with Alt Text
o Alttext is hidden text used to describe an image to one visually impaired.
* Bookmarks for documents over 9 pages
* Add tags
* Logical reading order (left-to-right) in tables
* No background images or watermarks
* Table rows that don’t split across pages

A checklist to ensure your PDF document is ADA compliant is provided by the U.S. Department of Health
and Human Services.

Before creating a PDF
Verify your document (Word or otherwise) is free of potential ADA problems before converting to a PDF.

Remove background image/watermark in Word
If your document has a watermark or background image, perform the following:
1. Open the Word document.
*  Perform one of the following:
* If using Word 2003/2010, click the Page Layout tab, and then select Watermark in the Page
Background group.
2. Ifusing Word 2013, click the Design tab, and then select Watermark in the Page Background
group.
3. Select Remove Watermark.



Prevent table rows from splitting across pages
If your document contains tables, perform the following:

1. In the Word document, click the table selection button at the top left of the table. The entire
table will be selected.

2. Click the Table Tools / Layout tab on the ribbon.
3. Click Properties in the Table group.

* The Table Properties dialog will appear.
4. Click the Row tab.

Table Properties

5. Uncheck the box for Allow row to break across pages.
6. Click OK.



Modify the PDF
Once a PDF has been created, either via scanning or by converting an existing document, you may need
to perform one or more of the following steps.

Tools Comment Share
Convert PDF to searchable text : :

If the PDF was created by scanning, perform the following: Eid _
» Pages
1. Open the PDF in Acrobat X Pro. » Content
2. Click the Toolsbutton on the right. » Forms
3. Click Recognize Textind then click In This File » Action Wizard
The Recognize Text dialog will appear. \% Recognize Text
x| m In This File

(" Current page
" From page Il to IZ

[~ Settings

Primary OCR Language: English (US)
PDF Qutput Style: Searchable Image
Downsample To: 600 dpi

Edit... |

5 ok | el |
4. ClickOK

5. When done, save the PDF.




Add Alt Text to Images

Open the PDF in Acrobat X Pro.

Choose View > Show/Hide > Navigation Panels > Tags.
Eile—gdk_m Window Help

Rotate View »

Page Navigation 3

Page Display 3

Zoom 3

Tools »

Comment »

Show/Hide 1 Navigation Panes J‘ (&) Accessibility Report
%] Read Mode CtrleH | &= Toolbar Items v UL Articles
L) =
Full Screen Mode Ctrl+L Menu Bar i | & Astachments
B Tracker.. Rulers & Grids v [ Bookmarks

Cursor Coordinates D Content
Read Out Loud Desti
Compare Documents... & Layers
{2 Model Tree

Order
[Tl Page Thumbnails
l? Signatures
v LD Tags
Hide Navigation Pane

Reset Panes

The Tags pane will appear on the left side of the window.

L4

Optional: Click the Options button and then
verify that Highlight Content is checked.
(If not, click on “Highlight Content”.)

Click the plus signs (+) to expand

the logical structure tree, then find and select the <Figure> tag

element for the desired image.

Tags
Click the Options button — and 5B Tage
select Properties... from the menu. 2 <safp

A TouchUp Properties dialog will appear.

Type text that describes the image
in the Alternate Text field.

Click Close.

#-7 <Figure>
\; <Figure>
E\; <Figure>
#F <Figure>
=9 <p>

Tags

New Tag...

Cut
Paste
Paste Child

Delete Tag

Find Tag from Selection
Create Tag from Selection
Eind...

Change Tag to Artifact..,

LCopy Contents to Clipboard

Edit Class Map...
Edit Role Map...

Tag Annotations

N Document is Tagged PDF

v Highlight Content

Show Metadata...

Properties...




Add Bookmarks

If the PDF document contains 9 or more pages, bookmarks should be added. Bookmarks allow the
reader to quickly navigate to points of interest within a PDF by linking to a specific page and view of that

page.

1. Open the PDF in Acrobat X Pro and navigate to the page to which you wish the bookmark to link.

2. Adjust the view settings, zooming in or out.

3. Using the Select tool , create the desired the desired image or text to bookmark:

* To bookmark a single image, click in the image or drag a rectangle around the image. «

To bookmark a portion of an image, drag a rectangle around the portion

* To bookmark selected text, drag to select it.

The selected text becomes the label of the new bookmark, though you can edit the label.

4. Click the Bookmarks - button (far left).
5. Click the Options button and click New Bookmark from the menu.

6. If desired, edit the text of the bookmark.

Run Accessibility Checker
Running the Accessibility Quick Check or Full Check to find potential problems.

1. Select View > Tools > Accessibility from the menu bar.

* Accessibility options will appear in the Tools pane on

the right. Tools Comment
2. Do one of the following: El~
* Select Quick Check. » Pages
o The results of the quick check will be displayed with G
any possible recommendations.
» Select Full Check and, when the Accessibility Full » Forms
Check options screen is displayed, click Start \ Action Wizard
Checking. Click OK at the result message screen. :
o An Accessibility Report will appear in the left pane, ’\Qe“g"'ze Text
listing potential problems, as well as links to \» P\Qte"ﬁ“
instructions on how to fix said problems. \ Sig\ & Certify

+\AcceXeibility

Ch%e Reading Options

@ \Quick Check
Full Check




Add Tags

PDF files should include structure, that is, a set of instructions that define how the content logically fits
together (e.g. correct reading order, the presence and meaning of significant elements such as figures,
lists, tables, etc.) In PDFs, structure is expressed via "tags" which can be automatically generated.

1. Open the PDF in Acrobat X Pro.

2. ChooseView > Tools> Accessibility

File Edit Window Help
Rotate View »
Page Navigation 4
Page Display »
Zoom » :
Tools Pages
Comment »| Content
Show/Hide »| Eorms
= 1 Action Wizard
» Read Mode Ctrl+H
Aras Recognize Text
[C] Full Screen Mode ctri+
Protection
[B Tracker... Sign & Certify
Read Out Loud »| Document Processing
Compare Documents... Print Production
JavaScript
Accessibility
Analyze

Accessibility will appear under the Tools menu on the far right. Tools ConIEnE

El-

\ &

Pages

Content

v

» Forms

v

Action Wizard

v

Recognize Text

Protection

v

v

Sign & Certify

A Recognition Report will appear

4

Accessibility

in the left pane, listing the location of

“ , 5 Change Reading Options
tags and the level of “confidence [ chang 5

@ Quick Check

@ Full Check

Open Accessibility Report

(e.g. high, medium, low, etc.) of each tag.

The report also contains links to instructions
on how to fix potential tagging problems.

@ Add Tags to Document

& z¢ 2EENIS =
3. Verify the tags match reading order.

4. Select Add Tags to Document




More information on using the Acrobat X Pro Accessibility Checker is available from Adobe.

More details on making PDFs ADA compliant is available from Adobe.
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